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1 Setting Up the postscript Kit

The following information can be found in this chapter:
» Checking the Contents

> Safety Notes

> Installing the postscript Kit



Checking the Contents

The devices and components bundled with the present product are
described below.

If any of the following are missing, contact your local Xerox office.

1 1]

| Wikinnman | s

possible with the printer.

fonts.

1 postscript Driver Library CD-ROM

Includes the postscript drivers and screen compatible with postscript.

License Agreement

Postscript Program ROM
This ROM makes postscript printing ‘(‘

Adobe' PostScript 3
postscript Logo Seal

This seal accompanies printers

Safety Notes

Be sure to observe the following when handling the kit.
Be sure to read “User Guide (Copier), Safety Notes” before you use the
printer.

WARNING: Never open or remove machine covers that are
secured with screws unless specifically instructed in the User
Guide. High-voltage components can cause electrical shocks.

WARNING: Do not try to alter the machine configuration or
modify any parts. Unauthorized modifications can cause fire.

CAUTION: Be sure to switch off the machine when installing the
device. Installing the device when power is switched on can
cause damage to the option and machine due to static electricity.

» Do not touch the ROM terminals.
» Do not bend or scratch the ROM.




Installing the postscript kit

This section describes how to install the postscript program ROM of the
postscript kit into the printer.

You can use the printer as a postscript compatible printer by installing
the postscript program ROM.

Follow the directions below to install the postscript program ROM.

Ensure that the optional 64MB SDRAM for printer has been installed
before installing the PostScript Kit.

Refer to the Printer Settings List to check whether the optional 64MB
SDRAM module is installed in your machine. See “User Guide
(Printer)” for details of the Printer Settings List.

You are recommended to install the optional printer HDD Kit to optimize
the PostScript features.

1. Make sure that the printer is off, and unplug the printer from the
outlet.

CAUTION: Be sure to switch off the machine when installing the
device. Installing the device when power is switched on can
cause damage to the option and machine due to static electricity.

When the power is off, all print data of the printer as well as print
data stored in the printer built-in memory is discarded. When
turning off the power, make sure that “Ready to print” is displayed.

When turning off the power, make sure that the Job in Memory
indicator lamp is off. Otherwise, data stored in the memory may be
discarded.

2. Remove the cover screw on the left side of the printer and remove
the cover.

i
°
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3. While holding the metal plate, loosen the 4 screws; first the lower
2, then the upper 2, to remove the metal plate.

T
i

4. Open the clip on top of the ROM2 slot (1). Hold the postscript
program ROM so that the notch is located as shown in the diagram
and insert it directly into the ROM2 slot (2).

Correctly insert the postscript program ROM into the ROM2 slot
and close the clip to fasten the ROM.

Securely push in the postscript program ROM.

Nl o
: frll] [ H
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5. Insert the 2 metal-plate notches into the printer and tighten the 4
screws to fasten.

-

6. Insert the 2 cover notches into the printer and tighten the screw to
fasten.

™

7. Affix the postscript 3 Logo seal to the printer as shown in the figure.

Adobe P

8. Plug in the printer and turn it on.

9. Print the Printer Settings List to confirm that postscript appears in
Options of the System Settings.

See “User Guide (Printer)”
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2 Operation at the Printer

The following information can be found in this chapter:
> Printer Settings
> Settings in Menus

> Setting Items



Printer Settings

This section describes how to set printer settings when using the
PostScript language.

Settings in Menus

When the PostScript kit is installed, the following items can be set by
the common menu on the printer control panel.

See “Setting Items” on page 2-4 for details.

You can also adjust the settings at CentreWare Internet Services. See
“User Guide (Printer)” for details.

Report/List PS Fonts List *:Default
|:PS Logical
Network/Port Parallel Print Mode — Auto*
—PCL
—PS
Adobe Protocol ———Normal*
— Binary
—TBCP
. LPD Print Mode Auto*
EPCL
PS
TBCP Filter Disable*
|:Enable

Auto*

L Netware Print Mode
EPCL
PS
TBCP Filter Disable*
|:Enable

Auto*

+——SMB Print Mode
EPCL
PS

TBCP Filter Disable*
|:Enable




Auto*

IPP Print Mode
E PCL
PS

TBCP Filter Disable*
[ Enable
- USB Print Mode — Auto*
—PCL
—PS
Adobe Protocol ———— Normal*
— Binary
- _TBPC
——— Port9100 Print Mode Auto*
E PCL
PS
TBCP Filter Disable*
I: Enable
L EtherTalk Port Status Disable*
|: Enable
PJL Disable*
L Enable

TPostScript
Buffer Size EtherTalk Memory



Setting Items

Make the following settings from the printer control panel according to
your operating environment.

> Port Status - Allows you to specify what port to use at startup.

> Print Mode - Allows you to make printer port settings and set the
necessary conditions for communication.

> Allocate Memory - Allows you to change the amount of memory
used by PostScript.

See “User Guide (Printer)” for details about how to make each setting.

You can also make settings at CentreWare Internet Services. See
“User Guide (Printer)” for details.

Port Status

Parallel/LPD/NetWare/SMB/IPP/USB/Port9100/EtherTalk - Activate
the port using PostScript language.

Print Mode

Allows you to set the print mode specifications of each port to enable
the use of the PostScript language. With a parallel and USB interface,
Print Mode allows you to set the Adobe Communication Protocol.

Print Mode for Parallel/LPD/NetWare/SMB/IPP/USB/Port9100
(Default: Auto) - Select Auto to use the PostScript printer on the
Windows operating systems.

Adobe Communication Protocol for Parallel/USB (Default:

Normal) - Specifies PostScript Communication Protocol for parallel
interface or USB.

Normal |Used when the communication protocol is in ASCII format.

Binary |Used when the communication protocol is in binary format.
Compared to Normal, print processing might be faster,
depending on the type of data.

TBCP Used when the communication protocol supports both
ASCII and binary data to switch between them according to
the specified control code.

In most circumstances, you should use the default, Normal.

Make settings according to the data format that the printer driver
installed on the computer.

The TBCP filter of LPD/NetWare/SMB/IPP/Port9100 (Default:
Disable) - When the communication protocol supports both ASCIl and
binary data, select Enable so that the filter can switch between them
according to specific control codes.

EtherTalk PJL (Default: Enable) - Specifies whether to use the PJL
command.

The PJL command is effective regardless of what printer language is
being used.




Allocate Memory

PS Memory (Default: 8 MB) - Sets the amount of memory used by
PostScript. Increasing PS memory speeds up print processing and
reduces occurrences of PostScript errors caused by insufficient
memory. Set the value in 0.25MB increments from 4.5 to 32.00 MB.
The maximum setting varies according to the amount of free memory.

EtherTalk Buffer Size (Default: 256 KB) - Sets the amount of memory
used by EtherTalk. Increasing the buffer size frees EtherTalk clients
more quickly. Set the value in 32KB increments between 64 and 1024
KB. The maximum setting varies according to the amount of free
memory.

Report/List Print

PostScript Fonts List - Allows you to confirm what PostScript fonts
can be printed with the machine.

PostScript Logical Printer List - Allows you to confirm what
PostScript logical printers are registered.

See “User Guide (Printer)” for details about how to print reports and
lists.

When printing with UNIX, a logical printer is created. Consult UNIX
documentation for details about how to create a logical printer.

Then use the CentreWare Internet Sevices to set the PostScript logical
printer on the machine. For details on the setting items, refer to the
online Help of CentreWare Internet Services.

For details on how to use CentreWare Internet Services see “User
Guide (Printer).

See the “Network Print Environment User Guide” (Network PDF) on the
Documentation CD Rom for details on using UNIX to print from the
machine.
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3 Operation with Windows 95/98/Me

The following information can be found in this chapter:
» About the Software
* Bundled Software
* Hardware/Software Requirements
> Installing the AdobePS Printer Driver
* Installation Procedure
> Printer Driver Properties
+ Configuration Tab Settings
* Options Tab Settings
* Output Settings Tab Settings
> How to Use Help



About the Software

Bundled Software

This section describes the software bundled with the PostScript Driver
Library CD-ROM for Windows 95, Windows 98, and Windows Me.

The following items are included in the “English\WCP423(or WCP428
depending on your printer model)\Win9x_Me” folder and
“English\Utility\Win9x_Me” folder in the enclosed CD-ROM. Also, be
sure to read “Readme.txt” containing cautionary notes about how to
use the printer driver.

AdobePS Printer Driver (ver.4.4.x) and PPD files - Adobe PostScript
driver and PPD files (for Windows 95/98/Me).

ATM (Adobe Type Manager)(ver.4.0) - Helps you install typefaces,
activate and manage your fonts.

Adobe Screen Fonts (TrueType/PostScript) - Includes 136 screen
fonts (19 TrueType fonts and 117 PostScript fonts), which are
compatible with the printer fonts. ATM is used to install the PostScript
screen fonts. When using these fonts to print, it is recommended that
you use the Adobe PostScript (4.4.x) printer driver.

Adobe Acrobat Reader - Allows you to view and print PDF files on all
major computing platforms.

Hardware/Software Requirements

The minimum system requirements for the Windows 95/Windows 98/
Windows Me printer driver are described below.

Computer System

> 1386, i486, or Pentium processor-based personal computer (i486 or
Pentium processor recommended)
> 8 MBytes of available RAM (16 MBytes recommended)

> 6 MBytes of available hard-disk space (8 MBytes required for full
driver installation)

Basic Software

» Windows 95, Windows 98 or Windows Me



Installing the AdobePS Printer Driver

Installation Procedure

Install AdobePS 4.4.x printer driver onto Windows 95, Windows 98 or
Windows Me by following the procedure below.

This section describes how to install the printer driver for Windows 98,
as an example.

Itis possible to cancel installation of the printer driver by clicking Cancel
in the dialog box displayed during installation. You can also click Back
to ignore the settings in that dialog box and return to the previous dialog
box.

1. Start Windows 98.
2. Insert the PostScript driver CD in the CD-ROM drive.
The Install program should run automatically.

il

PS Driver for

workeentre

PRO 423/428

3. Click Driver Installation.

The Welcome screen for the PostScript driver installation is
displayed.
4. Click the Copier/Printer tab.

Eﬂepiﬂf Printer E Port Monitor | Scanner E Contact

| | Welcome to the XEROX WorkCentre Pro PS driver Installer

Flease use the above menu for navigation. If you wish to install the Printer drivers, you
may oo s0 by selecting the "Copier / Printer” tab located on the menu

If you wish to install the Port Monitor utility, select the "Port Monitor" tab, also located
on the menu

ou will be asked to specify which operating system you are currently running. Once
you have made a selection, click the "Begin Installation” button in order to proceed
The InstallShielo® wizard will guide you through the rest of the setup process

THE DOCUMENT COMPANY

Exit | Maih XEROX




5. Click Begin Installation on the Copier/Printer tab.

" Copier / Printer

E Port Monitor | Scanner E Contact
3 " Installz

"/ Printer D|

The windows installer is for the following
wersions: 9x, Me, NT and 2000

Please select your current operating system

@ Microsoft Windows 3@
O MacOS @&

Begin Installation

. . THE DOCUMENT GOMPANY
Exit | Main XEROX

6. Click [Next] on the Welcome screen.

Herox WorkCe 4237428 Setup

‘Welcome

The InstallS hield® Wwizard will install xerox Work Centre Pro
4237428 on your computer. To continue, click Next,

eh Concel |

7. Read the License Agreement and click [Yes] to accept the
agreement.

Kerox WorkCentre Pro 423/428 Setup

License Agreement THE
5 DOCUMENT

COMPANY

XEROK

Flease read the following License Agreement. Press the PAGE DOWN key to see the rest of
the agisemertt

[LICENSE AGREEMENT FOR THE ENCLOSED SOFT'WARE AND RELATED il
DOCUMEMTATION

[YOUR LICENSE AGREEMENT - READ BEFORE INSTALLING SOFTWARE

IMPORTANT: THIS AGREEMENT CONTAINS THE LICENSE TERMS AMD =l

Do you accept all the tems of the preceding License Agieement? i you choose Mo, Setup wil
close. To install the Xerox WiorkCentrs Pro 423/428, you must accept the agresment

IF7stEtied]
< Back Yes Ho




8. Read the readme information and click [Next].

Xerox WorkCentre Pro 423/428 Setup | %]
Readme Information -

THE
DOCUMENT

XEROX

Xerox WorkCentre Pro 423/428 Setup.
Machine Type

10. Click the Setup button that you want to use to install the printer.

NOTE: It is recommended that you use the Typical button unless you
are an advanced user wanting to customize the installation.

Xerox WorkCentre Pro 423/428 Setup E3

Setup Options - THE
DOCUMENT

NERDX

IT

IFstalltield!

XEROX WorkCentre Pro 423/428 User Guide (PostScript® Kit) Page 3-5
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11. Check the information screen and click [Next].

T
A poc
COMPANY
XCROX

Fiinter to be created vl have the following conliguration =]

Xerox WorkCentre Pro 423/428 Setup

Information

The following options will be installed

PRINTEF DRIVER: ¥eron work Centre Pro 426

INSTALLED IN:
C:\Programsisieroxisieros WorkCentre Pro 423 & 428

README
INSTALLED IN:
C:\Programsi<erox<erox WorkCentre Pro 423 & 428

: o

IF7stEtied]

<Back [[THeds ]  Cancel |

12. Read the Printer Installation Information screen and click [Next].

Xerox WorkCentre Pro 423/428 Setup

Printer Installation Information THE
DOCUMENT
COMPANY
XEROX

Impartant Information. Flease read

o will need ta install the printer wsing the Add Printer ‘wizard, which will be launched whe
TOINSTALL YOUR PRINTER:

1. Select My Computer' and press Mext'

2. Gelect a port and press Nest

3. Select 'Have Disk!

4. Find 'C:\Programs'xeroxieon WorkCentre Pro 423 & 428\xxninf

< | _'Ij

IFstallstield

13. Make sure that the Select Printer Setup box is checked and click
[Finish] to launch the Add Printer Wizard and complete the
installation of the printer.

Herox WorkCe o 423/428 Setup

Printer Installation Information

The diiver installer has finished.

[# Gelect Prinker Setugt

*You now need to install the printer using the Add Printer
wfizard,

< Back Finish I (Eance]




14. Click [Next] to start the wizard.

Add Printer Wizard

Thig wizard will help you to install your printer quickly and
easily.

To begin inzstalling your printer, click Mext.

< Back Cancel |

15. Select how the printer is connected to the computer.

Select Local printer when the printer is connected directly to the
computer. Otherwise, select Network printer.

For a network connected printer:
i. Click the [Network printer] radio button then click [Next].

Add Printer Wizard

How iz this printer attached to your computer?

IFit is directly attached to your computer, click Local

Frinter. If it iz attached to another computer, click Metwork
Printer
" Lacal printer

< Back I Mext > I Cancel |

ii. Enterthe Network path or queue name for the printer or click
[Browse] and locate the printer. When the network path or
gqueue name is displayed, click [Next].

Add Printer Wizard

Type the network path or the queus name of your printer.
If you don't know its name, click Browse to view available
network printers.

Metwork path or queus name:

Browse. .. |

Do you print from kS-D05-bazed programs?
 Yes
i+ No

< Back I Mext > I Cancel




For a locally connected printer:
i. Click the [Local printer] radio button then click [Next].

Add Printer Wizard

How iz this printer attached to wour computer?

If it iz directly attached to pour computer, click Local
Printer. If it iz attached to another computer, click Metwork
Frinter

= Metwark printer

< Back I Mext » I Cancel

16. Click [Have Disk].

Add Printer Wizard

I/"? Click the manufacturer and model of your printer. [f your printer came with an
..,!T ¥ installation disk, click Have Disk. If pour printer iz not listed, consult pour printer
documentation for a compatible printer.

Manufacturers: Frinters:

AGFA-AccuSet 10005F v2013.108
AGFA-AccuSet 10005F 523

AGFA-AccuSet 1500
AGFA-AccuSet 15005F v2013.108
Bull AGFA-AccuSet 800
-tk LI ARFA-ArrSet BONSF w2N13 1058 LI

Have Disk... |

< Back I Mext » I Cancel |

17. Browse to where the driver files were installed.
If you installed the files on your workstation, the location will be:
C:\Program Files\Xerox\Xerox WorkCentre Pro 423 & 428
The driver file is called xrpsapeh.

18. Choose this file and click [Open].

19. Click [OK].

Install From Disk

Inzert the manufacturer's installation disk into
the drive selected. and then click OK.

Cancel |

Copy manufacturer's files from:

E:\EnglishDC2854win9x_Me j Browse. . |




20. Select your printer model from the Printers list and click [Next].

Add Printer Wizard

Click the manufacturer and model of your printer. |f yaur printer came with an
inztallation disk. click Have Disk. If your printer is not listed, consult your printer
dacumentation for & compatible printer.

Printers:
F Document Centre 235 PS

Llocument Centr

Have Dizk... |

< Back I Mest > I Cancel |

21. For Local Printer only, select the port that you are using and click
[Next].

Add Printer Wizard

Click the port you want ta uge with this printer, and then
click Mext.

Ayvailable ports:

C:A4WAs{1BECER.LPZ Unknown local port
C:\Program FileshAdobet\Acrobat 4. 05PDF Dutputh® pdf
COM1: Communications Port

CO2: Communications Port

FILE Creates a file on disk

LPT: EF1 I etwark, Printer Port

o] 941

LConfigure Port... |

< Back I Mext » I Cancel |

22. Type a name for the printer, specify whether you want to use the
printer as the default printer, then click [Next].

Add Printer Wizard

“You can ype a name for this printer, or you can use
the name supplied below, When you have finished,
click Mext.

FBrinter name:

Do you want your Windows-based programs to uze this
printer az the default printer?

i Yes
i No

< Back I Mext » I Cancel




23. Specify whether you want to print a test page, then click [Finish].

After vour printer iz installed, Windows can print a test
page zo you can confim that the printer is zet up properly.

whould vou like to print a test page?

< Back I Finizh I Cancel

Installation begins.
24. Read the End User License Agreement and click [Accept].

End User License Agreement E
g Flease read the following licensze agreement.
= Lsge the zcroll bar to view the rest of thiz agreement.

ELECTRONIC END USER LICENSE AGREEMENT j

FOR ADOBE PRINTER DRIVER

MOTICE TO USER: THIS IS A CONTRACT. BY INSTALLING THIS DRIVER
SOFTWARE, vOU ACCEPT ALL THE TERMS AND CONDITIONS OF THIS
AGREEMEMT. Please read thiz agreement carefully. This software package
containg Adobe Printer Driver Software ["'Driver Software'] and related
documentation. |n return for acquinng a license to use the Driver Software and
documentation, you agree to the following terms and conditions: TO ACCEPT
THIS AGREEMENT, PRESS YES. IF vOU DO NOT AGREE WITH THE
TERMS AMD COMDITIONS OF THIS AGREEMENT, PRESS NO AND QUIT.
'O WILL MOT BE ABLE TO USE THE DRIVER SOFTWARE.

1. Scope of Use. You may install and use the Driver Software
[i] on any number of printers containing PostScript software from Adobe and LI

To accept thiz agreement, click Accept.

If you select Decline, the printer driver will not be installed.

Decline |

25. If you click Decline, see “If you click Decline in the License
Agreement” on page 3-11 for details.

26. Confirm that a printer has been added in the Printers window.

B3 Printers M=l 3
J Fie Edt Yiew Go Favoites Help ‘ﬁ
j L ‘ ¥ -

Back Frard Up Cut
J Address I Prirters j

g

Add Printer HEnns
‘warkCentre
Pro 423 PS

|2 object(s] Y

This completes installation of the printer driver. Remove the CD-ROM
from the drive.

See “Printer Driver Properties” on page 3-12 to configure the printer.
Store your CD-ROM in a safe place.



If you click Decline in the License Agreement

If you click [Decline] in the End User License Agreement, the following
dialog box appears.

Exit Installation B
@ Inztallation iz not complete. |f vou exit now, the driver may not be installed comectly.

Do you want to exit now?

Click [No] to return to and continue the operation.
Click [Yes] to cancel installation. A printer is added in the Printers
window, but the printer driver is not installed properly.

When you right-click the printer and click Properties from the menu, the
Re-installation tab is added to the printer driver properties dialog box.
Follow the directions on that tab.

When you finish reinstalling the printer driver, see “Printer Driver
Properties” on page 3-12 to set up the printer.



Printer Driver Properties

This section describes printer specific settings included in the printer

driver properties.

> Configuration Tab
» Options Tab

> Output Settings Tab

To view the printer driver properties, select the printer icon in the
Printers window, then click Properties on the File menu.

Configuration Tab Settings

This section describes the settings of the Configuration tab.

Select the function that you want to set in Features List and change the
settings in the Change box below.

Xerox WorkCentre Pro 423 PS5 Properties

General I D etailz | Paper | Graphics I Fants

LChange

Features List

S atermnark & Configuration

Image E nhancement

Options I

On

Draft Mode off
Tranzparency Dividers Mone
Stapling MHone

Job Offzet Nane
Collated off

Custom Paper Auto Orientation On

Bypass Feed Orientation Landzcape

Select Substitute Tray

Available Printer bemony

Avwailable Font Cache

Select Job Owner

User 1D for Secure Print/S ample Print

Halftane

Usze Printer Settings
4053 KB

1441 KB

Use Login Mame

D ot256

Help

| Restare Defaults |

3

I PostScript
Output Settings

o |

Cancel

| Apply

See “Options Tab Settings” on page 3-15.



Settings

Halftone - Specifies the type of halftone.

When it is possible to adjust halftones in an application, this setting may
be disabled.

Image Enhancement - Specifies whether to use the Image
Enhancement function.

Selecting On smooths out the boundaries between black and white
when printing. This reduces jagged edges, thereby artificially
increasing the resolution of the image. When printing an image
(bitmap) composed of coarse halftone dots, smooth color gradation is
impossible in certain situations. In this case, select Off.

Draft Mode - Specifies whether to reduce the amount of toner used
when printing drafts.

When you select On, the overall printed color becomes lighter. This is
best for printing documents when print quality is not necessary.

Transparency Dividers - Specifies whether to use transparency
dividers and the source of the separators, if selected.

Select Auto for the paper source to automatically feed from the paper
tray with paper of the same size and in the same orientation as
transparencies.

> When anything other than Manual feed is selected for Paper source
in the Paper tab.

> When anything other than Transparency is selected for Paper type
in the Paper tab.

> When anything other than Center Output Tray is selected for Output
bin in the Paper tab.

> When the Duplex feature is selected in the Paper tab.

Stapling - Specifies whether to staple printed documents as well as the
position of the staple.

> You can staple 2 to 30 sheets.
> You cannot use staples in the following situations.

* When anything other than Finisher Tray Upper is selected for
Output bin in the Paper tab.

* When Job Offset is selected.

Job Offset - Shifting the output positions of adjacent jobs (print
command) or copies (sets) is called Job Offset. The positions of
adjacent jobs or sets of copies are shifted to either sides of the output
tray.

Collated - Selects whether to collate a multiple-page file per set when
they are printed.



Custom Paper Auto Orientation - Specifies whether to correct the
paper orientation when printing on custom paper.

When printing with custom paper, select On to correct the orientation
rotated at 90 degrees.

Bypass Feed Orientation - Specifies the paper orientation when
printing from the bypass tray. When you set the short side of the paper
in the bypass tray feed direction, select Landscape. When you set the
long side of the paper in the bypass tray, select Portrait.

Select Substitute Tray - Specifies what action to take when the paper
for the print size is not loaded in the machine.
> Use Printer Settings

Uses the printer setting. The settings can be confirmed on the
printer control panel.

> Display message
Displays paper supply messages on the printer control panel.
Printing is unavailable until paper is supplied.

> Use Nearest Size (with Zoom)

Selects the nearest paper size and prints. Automatically reduces
images for printing, as necessary.

> Use Nearest Size (no Zoom)
Selects the nearest paper size and prints in an equal size.
> Use Larger Size (with Zoom)

Prints in an equal size on paper larger than the original.
Automatically reduces images for printing, as necessary.

> Use Larger Size (no Zoom)

Prints in an equal size on paper larger than the original.

Available Printer Memory - Enter the amount of usable printer
memory (in KB) in the Edit box. Normally, it is not necessary to change
this.

Available Font Cache - Enter the amount of memory available for the
font cache (in KB) in the Edit box. Normally, it is not necessary to
change this.

Select Job Owner - The following selections are available:
> Use Login Name

Use your Windows Login Name as the job owner name. The job
owner name becomes the “Login User Name\Host Name”. You can
use up to 31 characters for the login name. If it exceeds 31
characters, only the first 31 characters are used.

» Enter Owner Name

Select this when you want to specify a custom job owner name.
Enter any job owner name in the Job Owner Name box. Up to 31
characters can be entered for the job owner name. If it exceeds 31
characters, only the first 31 characters are used. By default, this is
“Unknown User”.

User ID for Secure Print Sample Set - Secure Print/Sample Print is
effective when an optional printer HDD kit is installed. This item does
not appear unless Installed is selected for Hard Disk in the Options tab.



Options Tab Settings

Specify the User ID of Secure Print or Sample Print with a maximum of
24 alphanumeric characters. When the User ID is already specified, it
is displayed in the edit box. If you are using Secure Print, you also need
to enter a password. You can enter up to four digits and each input digit
appears as an asterisk.

This section describes the settings in the Options tab.

Select the settings that you want to make in Hardware Options and
change them in the Change box below. To use this function, it is
necessary to make appropriate settings in this tab.

Xerox WorkCentre Pro 423 PS5 Properties
General I Detailz I Paper I Graphics | Fonts I PostScript
“watermarks I Configuration Options Output Settings

Output Trayp Mat Installed
Paper Source 3 Trayps
Duplex Module Mat Installed
Offzet Catch Tray Mat Installed
ermary Standard 9EMEB
LChange Hard Digk.
| Mat Installed ;I
Help | Restore Defaults I

ak. I Cancel | Sl

Settings

Hard Disk - Specifies whether the printer HDD kit is installed.

Select Installed when the printer HDD kit is installed. When you select
Installed, it is possible to select Collated in the Configuration tab.

Bypass Tray - Specifies whether a bypass tray is installed.

Output Tray - Specifies whether an output tray is installed, as well as
its type.

Paper Source - Select Tray 4 when the additional tray kit is installed.
Duplex Module - Specifies whether a duplex unit is installed.

Select Installed when the duplex unit is installed. When you select
Installed, it is possible to select the Duplex feature in the Paper tab.

Offset Catch Tray - Specifies whether an offset catch tray is installed.

Select Installed when an offset catch tray is installed. When you select
Installed, it is possible to set Job Offset in the Configuration tab.

Memory - The printer memory is fixed at Standard 96 MB.



Output Settings Tab Settings

This section describes the settings in the Output Settings tab.

Xerox WorkCentre Pro 423 PS5 Properties EE
General I D etailz I Paper I Graphics I Fants | PostScript |
WWatermarks I Configuration I Options Output Settings
— Output Paper
Output Size -

— Secure Print/S ample FPrint

% None

£ Secure Bint Uszer [D: |

£ ) Cample Eit Password: |

Hetieye osument HName: j

[¥ Display warning message about Dutput S ettings

Ahbout.. | Help | Restore Defaults |

ak. I Cancel | Apply |

You can restore defaults by clicking Restore Defaults.

Output Paper

Output Size - Selects the size of the paper used for output. The output
is automatically enlarged or reduced, depending on the paper size
selected here and the paper size selected in the Paper tab.

For example, when you select B5 in Paper size in the Paper tab and A4
is selected here, the output is automatically enlarged and printed.
When you select None, the job is printed based on the paper size
selected in the application.

Secure Print/'Sample Print

Secure Printis a function that temporarily stores print jobs in the printer,
then prints them when instructed from the printer control panel.
Sample Printis a function that outputs only 1 copy when multiple copies
are specified. If there is no problem, it outputs the remaining sets of
copies.

By setting User ID for Secure Print/Sample Print in the Configuration
tab, a value appears in User ID or Password, allowing you to output
secure prints/sample prints.

None - Select when you do not want to output secure prints/sample
prints.

Secure Print - Select when you want to output secure prints.



Sample Print - Select when you want to output sample prints.

See “User Guide (Printer)” for details of the operation at the printer.

User ID - Displays the User ID for Secure Print or Sample Print. The
user ID displayed is the User ID specified on the Configuration tab. This
option can only be selected when the setting on the Configuration tab
has been completed. This is a display-only item and cannot be changed
here.

Password - Displays the password for Secure Print specified on the
Configuration tab. Each digit is represented by an asterisk. This option
can only be selected when the setting on the Configuration tab has
been completed. This is a display-only item and cannot be changed
here.

Retrieve Document Name - Select the method of specifying the
document name. If you have selected Auto Retrieve, the valid
document name can be up to 24 alphanumeric characters.

Document Name - When “Enter Document Name” is selected in the
Retrieve Document Name list, you can specify a document name with
a maximum of 24 alphanumeric characters.

Display warning message about Output Settings

When printing, the printer driver checks whether Output Size setting
conflicts with other settings.

When this is activated, a conflict dialog box appears if there is non-
conformity during printing. Check the content of the dialog box and
resolve the conflicting function to continue printing.

When this is inactive, no conflict dialog box appears, but the conflicting
setting is automatically resolved and printing continues.



How to Use Help

The following describes how to use Help.

Xerox WorkCentre Pro 423 PS5 Properties K E3

“wiatermarks I Configuration I Options I Output Settings
General I Detailz Paper I Graphics I Forits I PostScript

Faper size: Ad (2105297 mm) [209.9 % 297.0 mm

d - © 0 1

AF[297x+  AS([148x+  AG[105x+ B4[257x+ BS([182x+

2
Eaper bpe: |
— Paper contral Orientation
n O Potrait ¢ Landscape
== e
E I= | Betated
1] 3
Dunles Faper gounce:
S | AutaSelect Tray ;I
I Mane vI )
Cutput bin:
I Center Dutput Tray ;I
Faper type:
| Pain |

THE DOCUMENT COMPANY

Marginz. .. About... I Help | Hestoregefaultsl

ak. I Cancel | Apply |

1. Click ﬂ and a ? mark appears next to the pointer. You can then
click items for which you need explanations, opening a pop-up
window that contains relevant information. Click inside the pop-up
window to close it.

2. Click [Help], an explanation of the current tab appears as Help
information.



4 Operation with Windows NT 4.0

The following information can be found in this chapter:
» About the Software

* Bundled Software

* Hardware/Software Requirements
> Installing the AdobePS Printer Driver

* Installation Procedure
> Device Options and Print Settings

+ Device Settings Tab Settings

« Configuration Tab Settings

* Advanced Tab Settings

* Output Settings Tab Settings

> How to Use Help



About the Software

Bundled Software

This section describes the software for Windows NT 4.0 bundled with
the PostScript Driver Library CD-ROM.

The following items are included in the “English\DC423(or DC428
depending on your printer model)\NT40” folder and
“English\Utility\NT40” folder on the CD-ROM. Also, be sure to read
“Readme.txt” containing cautionary notes about how to use the printer
driver.

AdobePS Printer Driver (ver. 5.1.x) and PPD files - Adobe PostScript
driver and PPD files (for Windows NT 4.0).

ATM (Adobe Type Manager)(ver. 4.0) - Helps you install typefaces,
activate and manage your fonts.

Adobe Screen Fonts (TrueType/PostScript) - Includes 136 screen
fonts (19 TrueType fonts and 117 PostScript fonts), which are
compatible with the printer fonts. ATM is used to install the PostScript
screen fonts. When using these fonts to print, it is recommended that
you use the Adobe PostScript (5.1.x) printer driver.

Adobe Acrobat Reader - Allows you to view and print PDF files on all
major computing platforms.

Hardware/Software Requirements

The minimum system requirements for the Windows NT 4.0 printer
driver are described below.

Computer System

> 1486 or Pentium processor-based personal computer (i486 or
Pentium processor recommended)
> 16 MBytes of available RAM (32 MBytes recommended)

> 6 MBytes of available hard-disk space

Basic Software

Windows NT Workstation 4.0/Windows NT Server 4.0 (Service Pack 5
or above).



Installing the AdobePS Printer Driver

Installation Procedure

Install the AdobePS 5.1.x printer driver onto Windows NT by following
the procedure below.

Itis possible to cancel installation of the printer driver by clicking Cancel
in the dialog box displayed during installation. You can also click Back
to delete the settings in that dialog box and return to the previous dialog
box.

1. Start Windows NT 4.0.

2. Insert the PostScript driver CD in the CD-ROM drive.
The Install program should run automatically.

7 1 €N
i

il

PS Driver for

workeentre

PRO 423/428

3. Click Driver Installation.
The Welcome screen for the PostScript driver installation is
displayed.

4. Click the Copier/Printer tab.

Eﬂepiu! Printer E Port Monitor ln—lﬂ o

| | Welcome to the XEROX WorkCentre Pro PS driver Installer

Flease use the above menu for navigation. If you wish to install the Printer drivers, you
may oo s0 by selecting the "Copier / Printer” tab located on the menu

If you wish to install the Port Monitor utility, select the "Port Monitor" tab, also located
on the menu

ou will be asked to specify which operating system you are currently running. Once
you have made a selection, click the "Begin Installation” button in order to proceed
The InstallShielo® wizard will guide you through the rest of the setup process

. . THE DOCUMENT COMPANY
Exit | Maih XEROX




5. Click Begin Installation on the Copier/Printer tab.

" Copier / Printer

E Port Monitor | Scanner E Contact
3 " Installz

"/ Printer D|

The windows installer is for the following
wersions: 9x, Me, NT and 2000

Please select your current operating system

@ Microsoft Windows 3@
O MacOS @&

Begin Installation

. . THE DOCUMENT GOMPANY
Exit | Main XEROX

6. Click [Next] on the Welcome screen.

Herox WorkCe 4237428 Setup

‘Welcome

The InstallS hield® Wwizard will install xerox Work Centre Pro
4237428 on your computer. To continue, click Next,

eh Concel |

7. Read the License Agreement and click [Yes] to accept the
agreement.

Kerox WorkCentre Pro 423/428 Setup

License Agreement THE
5 DOCUMENT

COMPANY

XEROK

Flease read the following License Agreement. Press the PAGE DOWN key to see the rest of
the agisemertt

[LICENSE AGREEMENT FOR THE ENCLOSED SOFT'WARE AND RELATED il
DOCUMEMTATION

[YOUR LICENSE AGREEMENT - READ BEFORE INSTALLING SOFTWARE

IMPORTANT: THIS AGREEMENT CONTAINS THE LICENSE TERMS AMD =l

Do you accept all the tems of the preceding License Agieement? i you choose Mo, Setup wil
close. To install the Xerox WiorkCentrs Pro 423/428, you must accept the agresment

IF7stEtied]
< Back Yes Ho




8. Read the readme information and click [Next].

Xerox WorkCentre Pro 423/428 Setup | %]

Readme Information -

THE
DOCUMENT

XEROX

Xerox WorkCentre Pro 423/428 Setup.
Machine Type

10. Click the Setup button that you want to use to install the printer.

NOTE: It is recommended that you use the Typical button unless you
are an advanced user wanting to customize the installation.

Xerox WorkCentre Pro 423/428 Setup E3

Setup Options - THE
DOCUMENT

NERDX

IT

IFstalltield!
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11. Check the information screen and click [Next].

T
A poc
COMPANY
XCROX

Fiinter to be created vl have the following conliguration =]

Xerox WorkCentre Pro 423/428 Setup

Information

The following options will be installed

PRINTEF DRIVER: ¥eron work Centre Pro 426

INSTALLED IN:
C:\Programsisieroxisieros WorkCentre Pro 423 & 428

README
INSTALLED IN:
C:\Programsi<erox<erox WorkCentre Pro 423 & 428

: o

IF7stEtied]

<Back [[THeds ]  Cancel |

12. Read the Printer Installation Information screen and click [Next].

Xerox WorkCentre Pro 423/428 Setup

Printer Installation Information THE
DOCUMENT
COMPANY
XEROX

Impartant Information. Flease read

o will need ta install the printer wsing the Add Printer ‘wizard, which will be launched whe
TOINSTALL YOUR PRINTER:

1. Select My Computer' and press Mext'

2. Gelect a port and press Nest

3. Select 'Have Disk!

4. Find 'C:\Programs'xeroxieon WorkCentre Pro 423 & 428\xxninf

< | _'Ij

IFstallstield

13. Make sure that the Select Printer Setup box is checked and click
[Finish] to launch the Add Printer Wizard and complete the
installation of the printer.

Herox WorkCe o 423/428 Setup

Printer Installation Information

The diiver installer has finished.

[# Gelect Prinker Setugt

*You now need to install the printer using the Add Printer
wfizard,

< Back Finish I (Eance]




14. Click [Next] to start the wizard.

Thig wizard will help you to install your printer quickly and
easily.

To begin inzstalling your printer, click Mext.

< Back Cancel |

15. Select how the printer is connected to the computer.

Select [My Computer] if the printer is connected directly to the
computer or to the network in the TCP/IP(LPD) environment.
Select [Network printer server] in other cases.

For a network connected printer:
i. Click the [Network printer] radio button then click [Next].

Add Printer Wizard

How iz this printer attached to your computer?

IFit is directly attached to your computer, click Local

Frinter. If it iz attached to another computer, click Metwork
Printer
" Lacal printer

< Back I Mext > I Cancel |

ii. Enterthe Network path or queue name for the printer or click
[Browse] and locate the printer. When the network path or
queue name is displayed, click [Next].

Add Printer Wizard

Type the network path or the queus name of your printer.
If you don't know its name, click Browse to view available
network printers.

Metwork path or queus name:

Browse. .. |

Do you print from kS-D05-bazed programs?
 Yes
i+ No

< Back I Mext > I Cancel




For a locally connected printer:
i. Click the [My Computer] radio button then click [Next].

Add Printer Wizard

This wizard helps wou install your printer or make printer
connections. This printer will be managed by:

All zettings will be managed and configured on this
computer.

" Metwark printer server

Connect to a printer on anather machine. Al settings for
thiz printer are managed by a print server that has been zet
up by an administrator,

< Back I Mest > I Cancel |

i. Selectthe portyou are using and click [Next].

Add Printer Wizard

Click the check box nest to the port(z] pou want to uze.
Documents will print ta the first available checked port.

Ayvailable ports:

Fort | Description | Frinter |:|

Local Port Fe Documen...

etz Local Port

Oipra Local Port

[ comt: Local Port

[ comz: Local Port

C comM3: Local Port [~
Add Port.. | LConfigure Part... |

I Enable printer pooling

< Back I Mest » I Cancel |

16. Click [Have Disk].

Click the manufacturer and model of your printer. If your printer came with an
installation disk, click Have Disk. | your prinker is not listed, consult your
printer documentation for a compatible printer.

Manufacturers; FPrinters:
ﬂ AGFA-AccuSet v52.3 ﬂ
AGFA-AccuSetSF w523
AGFA-AccuSet 800
AGFA-AccuSet B00SF w523
AGFA-AccuSet BOOSF v2013.108

AGFA-ACcuSet 1000
LI AGFA-ArruSet 100NSF w52 3 LI

Have Disk... |
< Back I Mest » I Cancel |

17. Browse to where the driver files were installed.
If you installed the files on your workstation, the location will be:
C:\Program Files\Xerox\Xerox WorkCentre Pro 423 & 428
The driver file is called xrpsapeh.

18. Choose this file and click [Open].



19. Click [OK].

Install From Disk

=
—
—

E:AEnglishADIC2B55NT 40 =l

20. Select your printer model from the Printers list and click [Next].

Add Printer Wizard

-.'.'.:§

Fx DC FO6/606./506 CP PS
F Document Centre 235 PS
F Doc Ce i

21. Enter a printer name, specify if you want to use the printer as the
default printer, then click [Next].

Add Printer Wizard
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For a locally connected printer:
i. Select Not shared and click [Next].

We recommend that you install the driver on each computer
with the procedure appropriate to the OS.

Add Printer Wizard

Indicate whether this printer will be shared with other
network uzers, |f vou choose sharing give this printer a

share name.
" Shared i+
Share Name: |

Select the operating spstems of all computers that will be
printing to this printer.

“indowes 55 -
‘windows NT 4.0 MIPS
Wwindows MT 4.0 Alpha

Windows NT 4.0 PPC

Wwindows MT 3.5 or 3.51 x86

Windows MT 3.5 or 351 MIPS LI

< Back I Mest > I Cancel |

ii. Specify whether you want to print a test page, then click
[Finish].

Add Printer Wizard

After vour printer iz installed, you can print a test page so
you can confirm that the printer iz set up properly.

whould vou like to print a test page?

< Back I Finizh I Cancel

The installation begins.
22. Read the End User License Agreement and click [Accept].

End User License Agreement %]
g Flease read the following licensze agreement.
= Lsge the zcroll bar to view the rest of thiz agreement.

ELECTRONIC END USER LICENSE AGREEMENT j

FOR ADOBE PRINTER DRIVER

MOTICE TO USER: THIS IS A CONTRACT. BY INSTALLING THIS DRIVER
SOFTWARE, vOU ACCEPT ALL THE TERMS AND CONDITIONS OF THIS
AGREEMEMT. Please read thiz agreement carefully. This software package
containg Adobe Printer Driver Software ["'Driver Software'] and related
documentation. |n return for acquining a license to use the Driver Software and
documentation, you agree to the following terms and conditions: TO ACCEPT
THIS AGREEMENT, PRESS YES. IF vOU DO NOT AGREE WITH THE
TERMS AMD COMDITIONS OF THIS AGREEMENT, PRESS NO AND QUIT.
'O WILL NOT BE ABLE TO USE THE DRIVER SOFTWARE.

1. Scope of Use. You may install and use the Driver Software
[i] on any number of printers containing PostScript software from Adobe and LI

To accept thiz agreement, click Accept.

If you select Decline, the printer driver will not be installed.

Decline |

If you click Decline, see “If you click Decline in the License
Agreement” on page 4-12 for details.



23. Confirm that the printer has been added in the Printers window.

1 Printers =13
File Edit “iew Help
IJ,ﬂ Prirters j b 4 ||ﬁ|

Add Printer  F< Document
Centre 285 ...

J o j

=
4| | »

| 4 object(z] selected i

This completes installation of the printer driver. Remove the CD-ROM
from the drive.

See “Device Options and Print Settings” on page 4-13 to configure the
printer.

Store your CD-ROM in a safe place.



If you click Decline in the License Agreement

When you click Decline in the End User License Agreement, the
following dialog box appears.

Exit Installation =
@ Inztallation is not complete. |f vou exit now, the driver may not be installed comectly.

Do you want to exit now?

Click [No] to return to 13 and continue the operation.
Click [Yes] to cancel the installation. A printer is added in the Printers
window, but the printer driver is not installed properly.

Select the printer and click [Properties] on the File menu. The Re-
installation tab is added to the printer driver properties dialog
box.Follow the directions on that tab.

When you finish reinstalling, see “Device Options and Print Settings” on
page 4-13 to set up the printer.



Device Options and Print Settings

This section describes printer specific settings in the settings in the
printer driver properties and document presets.

> Installable Options in the Device Settings Tab

> Configuration Tab

> Printer Specific Sections in the Device Settings of the Advanced Tab
> Output Settings Tab

To view the Device Settings or Configuration tabs, select the printer
icon in the Printers window, then click Properties on the File menu.

To view the Advanced or Output Settings tabs, select the printericon in
the Printers window, then click Document Defaults on the File menu.

Device Settings Tab Settings

This describes Installable Options in the Device Settings tab.

To print correctly, it is necessary to make appropriate settings in this
tab.

Select the items in Installable Options and change the settings in the
Change Setting box at the bottom of the tab.

ermx workCentre Pro 428 PS Properties EHE
General I Paorts | Scheduling I Sharing I
Security Device Settings | Configuration
----- ¥ Send CTRL-D Before Each Job: <Mox ;I

o f Send CTRL-D After EachJob: <Yes»

----- ¥ Add Euro Curency Symbol to PostScript Fonts: <Mox
M Job Timeout: <0 seconds>

&i “wait Timeout: <300 seconds:
&i Minimum Font Size to Download az Outline: <100 pizel(s)>

----- &i b amirurn Font Size to Download as Bitmap: <600 pisellz)>

EIE Inztallable Options

----- 1% Bypass Tray : <Maot Installed:

& Cutput Tray: <Mat Installeds LI

— Change 'Hard Digk' S etting

ﬁ I Mat Installed

oK I Cancel |

Settings

Hard Disk - Specifies whether the printer HDD kit is installed.
Select Installed when the printer HDD kit is installed.
Bypass Tray - Specifies whether a bypass tray is installed.



Output Tray - Specifies whether an output tray is installed, as well as
its type.

Paper Source - Select 4 Trays when the additional tray kit is installed.
Duplex Module - Specifies whether a duplex unit is installed.

Select Installed when the duplex unit is installed. When you select
Installed, it is possible to set the Duplex Printing feature in the Page
Setup tab.

Offset Catch Tray - Specifies whether an offset catch tray is installed.

Select Installed when an offset catch tray is installed. When you select
Installed, it is possible to set Job Offset in the Advanced tab.

Configuration Tab Settings

This section describes the settings of the Configuration tab.

@ Xerox WorkCentre Pro 428 PS Properties EHE
General | Ports | Scheduling | Sharing |
Security I Device Settings Configuration

— Specify Job Owner

Select Job Owner: L= Login Name

— Secure Print/S ample Print

Usger |D: I

Fassnrd I

Fiestare Defaults |
()8 I Cancel |

Select Job Owner

The following selections are available:

Use Login Name - Use your Windows Login Name as the job owner
name. The job owner name becomes the “Login User Name\Host
Name”. You can use up to 31 characters for the login name. If it
exceeds 31 characters, only the first 31 characters are used.

Enter Owner Name - Select this when you want to specify a custom
job owner name. Enter any job owner name in the Job Owner Name
box. Up to 31 characters can be entered for the job owner name. If it
exceeds 31 characters, only the first 31 characters are used. By
default, this is “Unknown User”.

Secure Print/Sample Print

User ID - Secure Print/Sample Print is effective when an optional
printer HDD kit is installed. This item does not appear unless Installed
is selected for Hard Disk in Installable Options of the Device Settings
tab.



Specify the User ID of Secure Print or Sample Print with a maximum of
24 alphanumeric characters. When the User ID is already specified, it
is displayed in the edit box.

Password - If you are using Secure Print, you also need to enter a
password. You can enter up to four digits and each input digit appears
as an asterisk.

Advanced Tab Settings

This section describes the settings of Printer Features in the Advanced
tab.

Select the items in Printer Features under Document Options of the
Advanced tab and change the settings in the Change Setting box at the
bottom of the tab.

&% Xerox WorkCentre Pro 428 PS Default HE

Page Setup  Advanced | DutputSettingsl About I

; % TrueType Font: <Substitute with Device Fontr ;I
Eﬂh Document Options

----- @ Page Layout [M-up) Option: <MNormal [one-up]:

...gés PostScript Options
Elg% Priviter Features
% Halftore: <Dot256:

----- @ Image Enhancement : <0rn

- Draft Mode: <Oft>

1% Output Destination: <Center Output Trays

% Job Offset: <Mones

% Tranzparency Dividers: <Mones j

— Change 'Paper Size' Setting

[E] B4 (257:354mm) =]
% [E] B5 (1824257mm)

[E] BE [1284182mm)

@ Legal
B Letter

Ok I Cancel |

See “Device Settings Tab Settings” on page 4-13.

Settings

Halftone - Selects the type of halftone.

When it is possible to adjust halftones in an application, this setting may
be disabled.

Image Enhancement - Specifies whether to use the Image
Enhancement function.

Selecting On smooths out the boundaries between black and white
when printing. This reduces jagged edges, thereby artificially
increasing the resolution of the image. When printing an image
(bitmap) composed of coarse halftone dots, smooth color gradation is
impossible in certain situations. In this case, select Off.

Draft Mode - Specifies whether to reduce the amount of toner used
when printing drafts.



When you select On, the overall printed color becomes lighter.This is
best for printing documents when print quality is not necessary.

Output Destination - Selects the destination for output.

Job Offset - Shifting the output positions of adjacent jobs (print
command) or copies (sets) is called Job Offset. The positions of
adjacent jobs or sets of copies are shifted to either sides of the output
tray.

Transparency Dividers - Specifies whether or not to use transparency
dividers and the source of the dividers, if selected.

Select Auto for the paper source to automatically feed from the paper
tray with paper of the same size and in the same orientation as
transparencies.

> When anything other than Manual Feed is selected for Paper
Source in the Page Setup tab.

> When anything other than Transparency is selected for Media of
Paper/Output in the Advanced tab.

> When anything other than Center Output Tray is selected for Output
Destination of Printer Features in the Advanced tab.

> When the Duplex Printing feature is set in the Page Setup tab.

Bypass Feed Orientation - Specifies the paper orientation when
printing from the bypass tray. When you set the short edge of the paper
in the bypass tray feed direction, select Landscape. When you set the
long edge of the paper in the bypass tray, select Portrait.

Stapling - Specifies whether to staple printed documents as well as the
position of the staple.

> When anything other than Finisher Tray is selected for Output
Destination in the Advanced tab.

> When Job Offset is selected.
Custom Paper Auto Orientation - Specifies whether to correct the
paper orientation when printing on custom paper.

When printing with custom paper, select On to correct the orientation
rotated at 90 degrees.

Select Substitute Tray - Specifies what action to take when the paper
for the print size is not loaded in the machine.

Use Printer Settings - Use the printer setting. The settings can be
confirmed on the printer control panel.

Display message - Displays paper supply messages on the printer
control panel. Printing is impossible until paper is supplied.



Use Nearest Size (with Zoom) - Selects the nearest paper size
and prints in an equal size. Automatically reduces images for
printing, as necessary.

Use Nearest Size (No Zoom) - Selects the nearest paper size and
prints in equal size.

Use Larger Size (with Zoom) - Prints in an equal size on paper
larger than the original. Automatically reduces images for printing,
as necessary.

Use Larger Size (No Zoom) - Prints in an equal size on paper
larger than the original.

Output Settings Tab Settings

This section describes the settings in the Output Settings tab.

‘; Rerox WorkCentie Pio 428 PS5 Default [ 2] %]
Page Setupl Advanced  Output Settings |Ab0ut |
Secure Print/S ample Print
& None User D: I
" Secure Print
F. d: I
" Sample Print asswa
Eetieyve Macurment [ amme: IAuIU Fietieve j
[aiment Heme: I
[~ Enable EMF Spoaling
Restore Defaults |
Coel_|

Secure Print/Sample Print

Secure Printis a function that temporarily stores print jobs in the printer,
then prints them when instructed from the printer control panel.

Sample Printis a function that outputs only 1 copy when multiple copies
are specified. If there is no problem, it outputs the remaining sets of
copies.

By setting Secure Print/Sample Print in the Configuration tab, the
setting values appear in User ID or Password, allowing you to output
secure prints/sample prints.

See "User Guide (Printer)" for details of the operation at the printer.

None - Select when you do not want to output secure prints/sample
prints.

Secure Print - Select when you want to output secure prints.
Sample Print - Select when you want to output sample prints.



User ID - Displays the User ID for Secure Print or Sample Print. The
user ID displayed is the User ID specified on the Configuration tab. This
option can only be selected when the setting on the Configuration tab
has been completed. This is a display-only item and cannot be changed
here.

Password - Displays the password for Secure Print specified on the
Configuration tab. Each digit is represented by an asterisk. This option
can only be selected when the setting on the Configuration tab has
been completed. This is a display-only item and cannot be changed
here.

Retrieve Document Name - Select the method of specifying the
document name. If you have selected Auto Retrieve, the valid
document name can be up to 24 alphanumeric characters.
Document Name - When "Enter Document Name" is selected in the
Retrieve Document Name list, you can specify a document name with
a maximum of 24 alphanumeric characters.

Enable metafile spooling.

Enable EMF Spooling - Specifies the format in which print information
is spooled to disk.

Select this check box to spool in EMF (metafile) format. This reduces
the amount of time it takes to send jobs to the printer.

Deselect the check box to spool in RAW format. More time is required
to convert printing information, so the amount of time it takes to send

jobs to the printer increases.

If there seems to be a problem, deselect the check box.



How to Use Help

The following describes how to use Help.

&5 Xerox WorkCentre Pro 428 PS Default

r—
r—

OEUMERL I EmE: |—/
[MacumentEmes

1. Click . and a ? mark appears next to the pointer. You can then
click items for which you need explanations, opening a pop-up
window that contains relevant information. Click inside the pop-up
window to close it.

2. Click [Help], an explanation of the current tab appears as Help
information.
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5 Operation with Windows 2000

The following information can be found in this chapter:
» About the Software
* Bundled Software
* Hardware/Software Requirements
> Installing the Printer Driver
* Installation Procedure
> Device Options and Print Settings
+ Device Settings Tab Settings
« Configuration Tab Settings
» Advanced Options Dialog Box Settings
* Output Settings Tab Settings

> How to Use Help



About the Software

This section describes the software bundled with the PostScript Driver
Library CD-ROM for Windows 2000.

Bundled Software

The following items included in the enclosed CD-ROM are necessary
to use the printer on Windows 2000. Also, be sure to read “Readme.txt”
containing cautionary notes about how to use the printer driver.

Microsoft PScript 5 Driver and PPD files - Microsoft PScript 5 Driver
and PPD files (for Windows 2000).

Adobe Acrobat Reader - Allows you to view and print PDF files on all
major computing platforms.

Hardware/Software Requirements

The minimum system requirements for the Windows 2000 printer driver
are described below.

Computer System

> 1486 or Pentium processor-based personal computer (i486 or
Pentium processor recommended)

> 16 MBytes of available RAM (32 MBytes recommended)

> 6 MBytes of available hard-disk space

Basic Software

» Windows 2000 Professional
» Windows 2000 Server
» Windows 2000 Advanced Server



Installing the Printer Driver

Installation Procedure

Install MS PScript 5 printer driver onto Windows 2000 by following the
procedure below.

NOTE: It is possible to cancel installation of the printer driver by
clicking [Cancel] in the dialog box displayed during installation. You
can also click [Back] to delete the settings in that dialog box and
return to the previous dialog box.

NOTE: If you want to set up Port 9100, refer to “Network Print
Environment User Guide” (Network.pdf) in the “PCL Driver/Network
Utility” CD-ROM.

1. Start Windows 2000.

NOTE: Log on as a Power User group member or an Administrator.
Refer to the Windows 2000 documentation for details about the Power
User group.

2. Insert the PostScript driver CD in the CD-ROM drive.
The Install program should run automatically.

‘IJ iver Installation

Irowse CDROM

Readme

‘ -

PS5 Driver for

workeentre

PRO 423/428

3. Click Driver Installation.

The Welcome screen for the PostScript driver installation is
displayed.
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4. Click the Copier/Printer tab.

Eﬂepiﬂf Printer E Port Monitor | Scanner E Contact

| | Welcome to the XEROX WorkCentre Pro PS driver Installer

Please use the above menu for navigation. If you wish to install the Printer drivers, you
may oo s0 by selecting the "Copier / Printer” tab located on the menu

If you wish to install the Port Monitor utility, select the "Port Monitor" tab, also located
on the menu

ou will be asked to specify which operating system you are currently running. Once
you have made a selection, click the "Begin Installation” button in order to proceed
The InstallShielo® wizard will guide you through the rest of the setup process

" " THE DOCUMENT COMPANY
Exit | Main -

5. Click Begin Installation on the Copier/Printer tab.

" Copier / Printer

E Port Monitor | Scanner E Contact

Copier / Printer Driver Installation

The windows installer is for the following
wersions: 9x, Me, NT and 2000

Please select your current operating system

@ Microsoft Windows 3@
O MacOS @&

Begin Installation

. . THE DOCUMENT GOMPANY
Exit | Main XEROX

6. Click [Next] on the Welcome screen.

Xerox WorkCenl 4237428 Setup

‘Welcome

The InstallS hield® Wwizard will install eros work Centre Pro
4237428 on your computer. To continue, click Next,

e [CWeds ] Cancel |

7. Read the License Agreement and click [Yes] to accept the
agreement.




NOTE: If you click [No] the installation will terminate.

Xerox WorkCentre Pro 423/428 Setup | %]
License Agreement -

THE
DOCUMENT

XEROX

8. Read the readme information and click [Next].

Kerox WorkCentre Pro 423/428 Setup

Readme Information

Xerox WorkCentre Pro 423/428 Setup
Machine Type

eros b/ ork Centre Pro 423
e Pro 423

10. Click the Setup button that you want to use to install the printer.
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NOTE: It is recommended that you use the Typical button unless you
are an advanced user wanting to customize the installation.

Xerox WorkCentre Pro 423/428 Setup

Setup Options
’ Dm:umwr

IT

11. Check the information screen and click [Next].

Kerox WorkCentre Pro 423/428 Setup

Information
} mcquN'r

12. Read the Printer Installation Information screen and click [Next].

Xerox WorkCentre Pro 423/428 Setup

Printer Installation Information

13. Make sure that the Select Printer Setup box is checked and click
[Finish] to launch the Add Printer Wizard and complete the
installation of the printer.

Page 5-6
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Kerox WorkCentre Pro 423/428 Setup

Printer Installation Information

The driver installer has finished.

*You now need to install the printer using the Add Printer
‘wizard.

< Back Finish I (Eance]

14. Click [Next] to start the wizard.

Thig wizard will help you to install your printer quickly and
easily.

To begin inzstalling your printer, click Mext.

|

=

]
T
gty

< Back Cancel |

15. Select how the printer is connected to the computer.

Select Local printer when the printer is connected directly to the
computer. Otherwise, select Network printer.

For a network connected printer:
i. Click the [Network printer] radio button then click [Next].

Add Printer Wizard

Local or Network Printer
|z the printer attached to your computer?

[F the: printer is directly attached to your computer, click Local printer. IF it is attached ta
another computer, ar directly to the netwark, click Metwark printer.

" Local printer
¥ sutomnatically detect and install rmy Plug and Flay printer

< Back I Mext = I Cancel




ii. Enterthe printer name and click [Next] or click [Next]
to locate and choose the printer.

Add Printer Wizard

Locate Your Printer
How do you want to locate your printer?

If you don't know the name of the printer, wou can browse for one on the netwark.

‘What do you want to do?

(% Type the printer name, o click Next to biowse for a printer

Marne: I

~ Connect to a printer on the Intemet ar on vour intianet

URL: |

< Back I Mest > I Cancel |

iii. Click the [Yes] radio button to make the printer the
default printer or the [No] radio button not to make it
the default printer. Click [Next].

Add Printer Wizard

Default Printer

“'our computer will always send documents ta the default printer unless pou specify
othenwise.

Do wou want your Windows-based programs bo use this printer as the default printer?
s
" No

< Back I Mest > I Caticel

iv. Click [Finish].

Add Printer Wizard

Completing the Add Printer
Wizard

Y'ou have successfully completed the Add Printer wizard.

ou specified the following printer settings:

Mame: L5Y5_wWKC428-06_0 on PICASSO
Diefault: Yes

Location:

Comment:

To close thiz wizard, click Finish,

Canze

< Back




For a locally connected printer:
i. Click the [Local printer] radio button then click [Next].

Add Printer Wizard

Local or Metwork Printer
|5 the printer attached to your computer?

&

If the printer is directly sttached to your computer, click Local printer. 1F it is attached to
another computer, or directly to the network, click Metwark printer.

' Local printer

I~ Automaticaly detect and install my Plug and Play printer
~ Metwork printer

< Back I Next » I Cancel |

ii. Selectthe portyou are using and click [Next].

Add Printer Wizard

Select the Printer Port
Computers communicate with printers through ports.

&

Select the part you want your printer o use, |F the part is not lizted, you can create a
news port.

' Use the following port:

Part D' escription Printer =

Frinter Port F
LPT2: Printer Port
LPT3: Printer Port
COM1: Serial Paort
COM2: Serial Port
[RaE Gerial Prrt =l

Mote: Mast computers use the LPT1: port to communicate with a local printer.
" Create a new port:
Tipe Local Port j

< Back I Next » I Cancel |

When the printer is connected in the TCP/IP(LPD) environment:
+ Click [Create a new port].
+ Select [Standard TCP/IP Port] in the Type list and click [Next].
* Click [Next].

Add Standard TCP/IP Printer Port Wizard x|

Welcome to the Add Standard
TCP/IP Printer Port Wizard

“Y'ou uge this wizard to add a port far a network printer
Before continuing be sure that:

1. The device is tumed on.
2. The network is connected and configured.

To continue, click Mext.

< Back I Next » I Cancel




« Enter the IP address of the printer in Printer Name or IP Address,
then click [Next].

Add Standard TCP/IP Printer Port Wizard

Add Port %L
Faor which device do you want to add a port?
Se—=

Enter the Printer Name or I[P address, and a port name for the desired device.

Frinter MName or IP Address: ||

Part Name: I

< Back I Next > I Cancel |

iii. Click [Finish] in the dialog box that will be displayed.
16. Click [Have Disk].

Add Printer Wizard

Add Printer Wizard O
The manufacturer and model detemine which printer to uge, W

Select the manufacturer and maodel of your printer. [f pour printer came with an installation

disk, click Hawe Disk. [f your printer is not listed. consult your printer dacumentation for a
compatible printer.

Manufacturers: Printers;
i’ AGFAACcUSEt vB2.3 il
AGFA-AccuSetSF 523
AGFA-AzcuSet 300
AGFA-AccuSet B005F w523
AGFAAccuSet BO0SF v2013.108

AGFAAccuSet 1000
AGFAAcenBat 1NNNGEF .57 2 LI

Have Disk... |

-

< Back I Next > I Cancel |

17. Browse to where the driver files were installed.

If you installed the files on your workstation, the location will be:
C:\Program Files\Xerox\Xerox WorkCentre Pro 423 & 428
The driver file is called xrpsapeh.

18. Choose this file and click [Open].

19. Click [OK].

Install From Disk

x|
Insert the manufacturer's installation disk into the dive
selected, and then click OK.

Cancel

LCopy manufacturer's files from:

E:\English\D C285win2000 j Browse..




20. Select your printer model from the Printers list and click [Next].

Add Printer Wizard

Add Printer Wizard
The manufacturer and model determine which printer to use.

Select the manufacturer and model of yaur printer. [f pour printer came with an installation
disk, click Have Digk. [f your printer is not listed, consult your printer documnentation for a
compatible printer.

Printers

Fx DC 706/606/506 CP PS
Document Centre 235 PS

Have Disk... |

< Back I Next > I Cancel |

21. Enter the printer name, set whether you want to use it as the default
printer, and click [Next].

Add Printer Wizard

Name Your Printer
You must assign a name for this prinker.

Supply a name far thiz printer, Some programs do not support gerver and printer name
combinations of more than 31 characters.

Frinter narne:
F> Document Centre 285 PS5

Do pou want your Windows-bazed programs to uze this printer as the default printer?
& ‘es
Mo

< Back I Next » I Cancel |

22. For local printer only, select [Do not share this printer] and click
[Next].
We recommend that you install the driver on each computer with
the procedure appropriate to the OS.

Add Printer Wizard

Printer Sharing

‘You can share this printer with other network users 2

Indicate whether pou want this printer to be available to other uzers. If pou share thiz
printer, you must provide a share name:

' Do not share this printer
" Share as

< Back I Next » I Cancel




23. Specify whether or not to print a test page, then click [Next].

Add Printer Wizard

Print Test Page
To confirm that the printer iz installed properly, you can print 3 test page.,

Do pou want to print a test page?
i Ves
Mo

< Back I Next > I Cancel

24. Click [Finish].
Add Printer Wizard

Completing the Add Printer
Wizard

You have successfully completed the Add Printer wizard.

“vou specified the following printer settings:

Mame: F Document Centre 285 PS
Shared as: <Moot Shared>

Port: IP_132168.128.19

Model: Fx Document Centre 285 PS
Default: Yes

Test page:  Yes

Ta cloge this wizard, click Finish.

< Back I Firish I Cancel

Installation begins.
25. Confirm that the printer has been added in the Printers window.

B3 Printers - - Ol =|

>

J File Edit Wiew Fawvorites Tools
J 4= Eack ~ = - | ‘E search =
J.ﬁ.ddress I Printers ;I ﬁG‘:‘

add Prinker Fix Document
Cenktre 285

.

-
A | 3

|5 objecki=) o




This completes the installation of the printer driver. Remove the CD-
ROM from the drive.

See “Device Options and Print Settings” on page 5-14 to set up the
printer.

Store your CD-ROM in a safe place.



Device Options and Print Settings

This section describes the settings specific to the printer, which are
among the settings to be made using the printer driver properties. For
other items, refer to the Help.

> Installable Options in the Device Settings Tab
> Configuration Tab

> Sections Specific to the Printer in Printer Features of the Advanced
Options Dialog Box

> Output Settings Tab

See “How to Use Help” on page 5-20 for details about how to use Help.

To view the Device Settings or Configuration tab, select the printer in
the Printers window, then click Properties on the File menu.

To view the Advanced Options dialog box, select the printer in the
Printers window, then click Printing Preferences on the File menu. Click
Advanced in the Layout screen.

To view the Output Settings tab, select the printer in the Printers
window, then click Printing Preferences on the File menu.

Device Settings Tab Settings

This describes Installable Options in the Device Settings tab. To print
correctly, it is necessary to make the appropriate settings in this tab.

Select the items in Installable Options and change the settings in the
menu that appears on the right.

& Xerox WorkCentre Pro 428 PS Proper!:;:j 2=l
General I Sharing | Parts I Advanced
Security Device Settings | Configuration

- Tray 4: Mot Svailable ;I

foene: Manual Feed: Mot Available
[1@3 Font Subskitution Table

------------- Available PostScripk Memory: 3958 KB

------------- Cutput Protocaol: ASCIT

------------- Send CTRL-D Before Each Job: Mo

------------- Send CTRL-D After Each Job: Wes

------------- Job Timeout: 0 seconds

Wait Timeout: 300 seconds

inimum Font Size ko Download as Qutline: 100 pixel{s)
------------- Maximurn Fonk Size to Download as Bitmap: 600 pixel(s)
EE Ins!
- Hard Disk: Mok Installed

- Bwpass Tray : Mot Installed

tallable Options

- Qukput Tray: Mot Installed

- Paper Source: 3 Traws
- Duplex Madule: Mot Installed
- Offset Catch Tray : Mok Installed

ak. I Cancel Apply




Settings

Hard Disk - Specifies whether the printer HDD kit is installed.
Select Installed when the printer HDD kit is installed.
Bypass Tray - Specifies whether a bypass tray is installed.

Output Tray - Specifies whether an output tray is installed, as well as
its type.

Paper Source - Select 4 Trays when the additional tray kit is installed.
Duplex Module - Specifies whether a duplex unit is installed.

Select Installed if the duplex unitis installed. When you select Installed,
it is possible to set the Duplex Print feature in the Layout tab.

Offset Catch Tray - Specifies whether an offset catch tray is installed.

Select Installed when an offset catch tray is installed. When you select
Installed, it is possible to set Job Offset in the Advanced Options dialog
box.

Configuration Tab Settings

This section describes the settings of the Configuration tab.

&% Xerox WorkCentre Pro 428 PS Proper!.f: 2xl

General I Sharing Fortz | Advanced |
Security I Device Settings Configuration

— Specify Job Dwher

Select Job Owner: Use Login Mame

— Secure Print/Sample Frint

Uszer ID: I

Fazsword: I

Restore Defaults |
QK I Cancel | Apply |

Specify Job Owner

The following selections are available:

Use Login Name - Use your Windows Login Name as the job owner
name. The job owner name becomes the “Login User Name\Host
Name”. You can use up to 31 characters for the login name. If it
exceeds 31 characters, only the first 31 characters are used.

Enter Owner Name - Select this when you want to specify a custom
job owner name. Enter any job owner name in the Job Owner Name
box. Up to 31 characters can be entered for the job owner name. If it
exceeds 31 characters, only the first 31 characters are used. By
default, this is “Unknown User”.



Secure Print/Sample Print

User ID - Secure Print/Sample Print is effective when an optional
printer HDD kit is installed. This item does not appear unless Installed
is selected for Hard Disk in the Device Settings tab.

Specify the User ID of Secure Print or Sample Set with a maximum of
24 alphanumeric characters. When the User ID is already specified, it
is displayed in the edit box.

Password - If you are using Secure Print, you also need to enter a

password. You can enter up to four digits and each input digit appears
as an asterisk.

Advanced Options Dialog Box Settings

This section describes the settings of the Advanced Options dialog box
displayed when clicking Advanced in the Layout tab.

Select the items from Printer Features and change them on the menu
displayed to the right.

&® Fx Document Centre 285 PS Printing Preferences 21

Layaut I Paper.fE!ualllyl Output Sett\ngsl About I

r— Orientation
& Poai
" Landscape
¢ Rotated Landscape

—Page Oider
& Front to Back
¢ Back to Front

Pages Per Sheet: |1 'I

Advanced... |
FX Document Centre 285 PS5 Advanced Options 21x1

Cancel Ap %’és Fx Document Centre 285 PS Advanced Document Settings
— % Paper/Output
@ iaraphic
Eﬁ& Diocurnent Options
. Adwanced Printing Features: Enabled

---ﬁs PostScripk Options

Eg% Printer Features
............. Halftone: Dok256
Image Enhancement : On
Draft Mode: Off
Cutput Destination: Center Oubpuk Tray
Job OFFset: Wone
Transparency Separakors: Mone

Bypass Feed Orientation: Landscape

Stapling: Mone

Cuskorn Paper Auko Crientation: On

Select Substitute Tray: Use Printer Settings

u]: I Cancel

Settings

Halftone - Selects the type of halftone.

When it is possible to adjust halftones in the application, this setting
may be disabled.



Image Enhancement - Specifies whether to use the Image
Enhancement function.

Selecting On smooths the boundaries between black and white when
printing. This reduces the jagged edges, thereby artificially increasing
the resolution of the image. When printing an image (bitmap)
composed of coarse halftone dots, smooth color gradation is
impossible in certain situations. In this case, select Off.

Draft Mode - Specifies whether to reduce the amount of toner used
when printing drafts.

When you select On, the overall printed color becomes lighter. This is
best for printing documents when print quality is not necessary.

Output Destination - Specifies the output destination.

Job Offset - Shifting the output positions of adjacent jobs (print
command) or copies (sets) is called Job Offset. The position of the
previous job or set of copies is shifted to the front and the next job or
set of copies is shifted to the back.

Transparency Dividers - Specifies whether or not to use transparency
dividers and the source of the dividers, if selected.

Select Auto for the paper source to automatically feed from the paper
tray with paper of the same size and in the same orientation as
transparencies.

> When anything other than Manual Feed is selected for Paper
Source in the Paper/Quality tab.

> When anything other than Transparency is selected for Media in the
Paper/Quality tab.

> When anything other than Center Output Tray is selected for Output
Destination in the Advanced Options tab.

> When the Duplex feature is selected in the Layout tab.

Bypass Feed Orientation - Specifies the paper orientation when
printing from the bypass tray. When you set the short edge of the paper
in the bypass tray feed direction, select Landscape. When you set the
long edge of the paper in the bypass tray, select Portrait.

Stapling - Specifies whether to staple printed documents as well as the
position of the staple.

> When anything other than Finisher Tray is selected for Output
Destination in the Advanced Options tab.

» When Job Offset is selected.



Custom Paper Auto Orientation - Specifies whether to correct the
paper orientation when printing on custom paper.

When printing with custom paper, select On to correct the orientation
rotated at 90 degrees.

Select Substitute Tray - Specifies what action to take when the paper
for the print size is not loaded in the machine.

Use Printer Settings - Uses the printer setting. The settings can
be confirmed on the printer control panel.

Display message - Displays paper supply messages on the printer
control panel. Printing is unavailable until paper is supplied.

Use Nearest Size (with Zoom) - Selects the nearest paper size
and prints. Automatically reduces images for printing, as
necessary.

Use Nearest Size (no Zoom) - Selects the nearest paper size and
prints in an equal size.

Use Larger Size (with Zoom) - Prints in an equal size on paper
larger than the original. Automatically reduces images for printing,
as necessary.

Use Larger Size (no Zoom) - Prints in an equal size on paper
larger than the original.

Output Settings Tab Settings

This section describes the Output Settings tab.

&% xerox WorkCentre Pro 428 PS Printing Pre[e 2l

Layoutl Paper/Quality  Output Settings |Aboul I

Secure Print/Sample Print

& Hore User ID:
£ Secure Rrint
. P. d
= Sample Frint asswe
Fietrieyve Dacument Mams: IAutU FRetrigve j

Dacurnent arme: I

Restore Defaults

Ok Cancel Aoply

Secure Print/Sample Print

Secure Printis a function that temporarily stores print jobs in the printer,
then prints them when instructed from the printer control panel.

Sample Printis a function that outputs only 1 copy when multiple copies
are specified. If there is no problem, it outputs the remaining sets of
copies.

By setting Secure Print/Sample Print in the Configuration tab, the
setting values appear in User ID or Password, allowing you to output
secure prints/sample prints.



See “User Guide (Printer)” for details of the operation at the printer.

None - Select when you do not want to output secure prints/sample
prints.

Secure Print - Select when you want to output secure prints.
Sample Print - Select when you want to output sample prints.

User ID - Displays the User ID for Secure Print or Sample Print. The
user ID displayed is the User ID specified on the Configuration tab. This
option can only be selected when the setting on the Configuration tab
has been completed. This is a display-only item and cannot be changed
here.

Password - Displays the password for Secure Print specified on the
Configuration tab. Each digit is represented by an asterisk. This option
can only be selected when the setting on the Configuration tab has
been completed. This is a display-only item and cannot be changed
here.

Retrieve Document Name - Select the method of specifying the
document name. If you have selected Auto Retrieve, the valid
document name can be up to 24 alphanumeric characters.

Document Name - When “Enter Document Name” is selected in the
Retrieve Document Name list, you can specify a document name with
a maximum of 24 alphanumeric characters.



How to Use Help

The following describes how to use Help.

ﬁ' Xerox WorkCentre Pro 428 PS5 Properti ﬂil
General I Sharing | Parts I Advanced
Security Device Settings | Configuration

Tray 4: Mok Available ;I
Marual Feed: Mok fvailable

@8 Font Substiution Table

Available PostScripk Memory: 3958 KB

Cutput Protocaol: ASCIT

Send CTRL-D Before Each Job: Mo

-~ 5end CTRL-D After Each Job: Wes

- Job Timeout: 0 seconds

- YWait Timeouk: 300 seconds

Minimum Fonk Size ko Download as Outline: 100 pixel(s)
------------- Maximurn Fonk Size to Download as Bitmap: 600 pixel(s)

Hard Disk: Mot Instaslled
Bwpass Tray : Mot Installed
Cukput Tray: Mot Installed
Paper Source: 3 Traws
Duplesx Madule: Mot Install=d
Offset Catch Tray : Mot Installed =

ak. I Cancel | Apply |

1. Click ﬂ and a ? mark appears next to the pointer. You can then
click items for which you need explanations, opening a pop-up
window that contains relevant information. Click inside the pop-up
window to close it.

2. Click [Help], an explanation of the current tab appears as Help
information.



6 Operation on Macintosh Computers

» About the Software
* Bundled Software
* Hardware/Software Requirements
> Installing the AdobePS Printer Driver
* Installation Procedure
+ Setting the Printer Driver
> Options
» Configure Settings
* Printer Specific Options Settings
> Installing the Screen Fonts
> Xerox PS Utility
* Installing the Xerox PS Utility
+ Uninstalling the Xerox PS Utility
* Using the Xerox PS Utility



About the Software

Bundled Software

This section describes the Macintosh software bundled on the
PostScript Driver Library CD-ROM.

Insert the CD-ROM and double-click the XOPS-PS icon to display the
Window. The following items are contained in the folder:

AdobePS Printer Driver (ver. 8.5.1, 8.7.0, and 8.7.1) and PPD files -
Adobe PostScript driver and PPD files (for Macintosh).

Xerox PS Utility - Enables you to define your printer settings.

Adobe Screen Fonts - Contains 117 PostScript fonts and 19
TrueType fonts, which are standard for PostScript 3 printers. In
addition, 37 PostScript fonts of Central European (CE) character set
are included.

ATM (Adobe Type Manager) - Helps you to install typefaces, activate
and manage your fonts. Two versions of ATM, versions 4.0.2and 4.5.2,
are included for Macintosh. Use version 4.5.2 when your operating
system is Mac OS 9.0.

Adobe Acrobat Reader - Allows you to view and print PDF files on all
major computing platforms.

Readme.txt - Contains cautionary notes about how to use the printer
driver. Be sure to read this before use.

Hardware/Software Requirements

The minimum system requirements for the Macintosh printer driver and
the utility are described below.

Computer System

» For AdobePS 8.5.1 - Mac OS 7.1 or later

> For AdobePS 8.7 - An Apple Power Macintosh computer running
System 8.1 or later

> For AdobePS 8.7.1 - Mac OS 8.6 through 9.1
> 4 MBytes or more of available RAM (32 MBytes recommended)

> 2.1 MBytes of available hard-disk space (4 MBytes recommended)



Installing the AdobePS Printer Driver

Installation Procedure

This section describes how to install the Adobe printer driver and how
to set the printer driver for this machine. There are two steps to install
the printer driver. Firstly, use the installer enclosed in the CD-ROM to
install the printer to the Macintosh. Then, configure the printer driver
according to the printer used.

This section describes the procedures for installing the AdobePS
printer driver.

As an example, here is the procedure to install AdobePS 8.7.1.

1. Insert the PostScript Driver Library CD-ROM in the CD-ROM drive.
The PostScript icon appears on the desktop.

2. Double-click the PostScript icon.

3. Double-click the [DC423] or [DC428] folder depending on your
printer model, and then the “AdobePS871” folder.

4. Double-click [AdobePS Installer 8.7.1].
5. Click [Continue].

A

"
&

Adobe PostScript Driver wss..

This installation was created with Installer YISE from MindVision Software

6. Read through the license agreement carefully and if you have no
objections to it, click [Accept].

License

ADOBE SYSTEMS INCORPORATED B
ELECTRONIC END USER LICENSE AGREEMENT

NOTICE TO USER:

THIS IS A CONTRACT. BY INDICATING YOUR ACCEPTANCE BELOW, YOU ACCEPT ALL THE TERMS AND
CONDITIONS OF THIS AGREEMENT INCLUDING IN PARTICULAR THE LIMITATIONS ON: USE CONTAINED IN
SECTIONS 2 AND 4; AND WARRANTY AND LIABILITY IN SECTION 5. YOU AGREE THAT THIS
AGREEMENT IS ENFORCEABLE LIKE ANY WRITTEN NEGOTIATED AGREEMENT SIGNED BY YOU.

This End User License Agreement accompanies the PostScript(r) driver software product, other
software and related explanatory materials collectively the ("Software").

Upon your acceptance of this Agreement, Adobe grants to you a nonexclusive license to use the
Software, provided that you agree to the following:

1. Definitions. "Adobe" means Adobe Systems Incorporated, a Delaware corporation, 345 Park
Avenue, San Jose, California 85110, if subsection 6(a) of this Agreement applies; otherwise it
means Adobe Systems Benelux BV, Europlaza, Hoogoorddreef S4a, 1101 BE Amsterdam Z0, the
Netherlands, a company organized under the laws of the Netherlands and an affiliate and licensee

]

[ Print... ][ Save As... ][ Decline ][ Accept ]

Read the Read Me displayed, then click [Continue].



7. Confirm the Install Location and change it if necessary, then click
Install.

AdobePs Installer8. 7.1 &=————-&H 8

Click the Install button to install
» Easy Install

— Install Location

“ P __Ql.lit
m The folder * AdobePS Components * will be created on the

disk “MacOSIE "

Installation begins.
When installation is complete, the dialog box appears.
8. Click [Quit].

s No installation was necessary. The files to be
installed are already on your disk, or are not
needed for your hardware setup.

Ifyou are finished, click Quit to leave the
Installer. If you wish to perform additional
installations, click Continue.

[continue ] [ oquit ||

This completes installation.
Proceed to “Setting the Printer Driver” on page 6-5 to continue.



Setting the Printer Driver

When you finish installing the AdobePS printer driver, set the
PostScript Printer Description (PPD) file for this machine to the printer
driver.

The printer driver controls the functions of this machine based on the
information in the PPD file.

1.
2.

Make sure that the machine is on.

Check that the machine’s EtherTalk port is set to Enable.

You can check the EtherTalk settings in the Printer Settings List.
See “User Guide (Printer)” for details about how to print the Printer

Settings List.

On the Apple menu select [Chooser], then click [AdobePS].

Select your printer from the Select a PostScript Printer list box,
which appears to the right of the Chooser, then click [Create].

(] Chooser B
Select a PostScript Printer:
Document Centre 285
PEFEES applehare L Document Centre 706/606/506
_ DocuPrint 400
% | DocuPrint C1250
L ==t L= DocuPrint C2221
Folor S 1500 Color 52500 [« FLUI XEROX DocuCentre 450/5...
FX DocuColor 1250 PLW
AppleTalk Zones: FX DocuColor 1250 PLW (EREs...
SBS ETalk FX DocuPrint C2220 ART EX
SB35 LTalk FX DocuPrint C620 XPL2
SBY ETalk LimoP 147 -
SB7 LTalk
BBSEther |
BEY ETalk -
BEY LTalk a i
@& Active
- AppleTalk )
9BS AR (D Inactive 7.6.2

This automatically searches for the printer and sets the PPD file.
If the search for the PPD file is not automatically performed

* Click Select PPD.

+ Select your printer model in the list, then click [Select].

i Printer Descriptions | %

Select a PostScript™ Printer Description File:

= Macintosh HD

(] FX DC 706/606/506 CP PS

(] X Document Cetnre 235PS
L] X Document Cetnre 285PS
FXAB2FE4.PPD
FXDC40E1.PPD
FXDCS5E2.PPD

Eject

Select I

Printer Model:

FX Document Centre 285v3011.106 PS

The PPD file for this machine is set.

“FX Document Cetnre 285 P5”

Current Printer Description File (PPD} Selected:

[ Auto Setup ]

[ selectPPD.. |

[ Printer Info ] [

Configure ]

Cancel




5. Click [Configure] to set the options.
See “Options” on page 6-7 for details about the options.

m Current Printer Description File (PPD) Selected:
' “FX Document Cetnre 285 P5*

Installable Options

Memory: | Standard 96MB ¥
Hard Disk: | Not Installed ¥ I

Bypass Tray: [ Not Installed i]
Output Tray: | Not Installed B

Paper Source: | 3Trays ¥ I

[ cancel ||[ ok |

6. Click [OK]. Click [OK] once more in the screen displayed.
7. Close the Chooser.



Options

Configure Settings

This section describes the Configure in the Chooser and the Printer
Specific Options of the printer driver.

This section describes Installable Options. To print correctly, these
settings must be correct.

1. Select the printer using the Chooser and click [Setup].

The Current Printer Description File (PPD) Selected dialog box
appears.

2. Click [Configure].

m Current Printer Description File {PPD) Selected:
= “FXDocument Cetnre 285P5"

[ Autosetup | [ SelectPPD.. |
[ Printerinfo | [ Configure |

The Installable Options list appears.
3. Set the option menu items in Installable Options, and click [OK].

m Current Printer Description File (PPD) Selected:
' “FX Document Cetnre 285 P5*

Installable Options

Memory: | Standard 96MB ¥
Hard Disk: | Not Installed ¥ I

Bypass Tray: [ Not Installed i]
Output Tray: | Not Installed B

Paper Source: | 3Trays ¥ I

[ cancel ||[ ok |

Settings

This section describes the items to set in Installable Options.
Memory - The printer memory is fixed at Standard 96 MB.
Hard Disk - Specifies whether the printer HDD kit is installed.
Select Installed when the printer HDD kit is installed.

When you select Installed, it is possible to set Collated in Printer
Specific Options.
Bypass Tray - Specifies whether a bypass tray is installed.

Output Tray - Specifies whether an output tray is installed, as well as
its type.

Paper Source - Select 4 Trays when the additional tray kit is installed.
Duplex Module - Specifies whether a duplex unit is installed.



Select Installed when the duplex unit is installed. When you select
Installed, it is possible to set the Duplex Print feature.

Offset Catch Tray - Specifies whether an offset catch tray is installed.

Select Installed when an offset catch tray is installed. When you select
Installed, it is possible to set Job Offset in Printer Specific Options.

Printer Specific Options Settings

This section describes Printer Specific Options, used to set the printer
driver.

1.  On the File menu of the application, click [Print].
The Print dialog box appears.
2. Select [Printer Specific Options].

2.7.1 (1081
Printer: [Document Centre 285 i] Destination:
- |« General
Background Printing
Cover Page [ Collate []Reverse Order
Color Matching
Layout
Error Handling To:
PostScript Settings :l o |:|
P”.n.ter Specific Oftmn.s_ 'Z": from: [Auto Select i]
Q First page from: | Tray 1 2]
Remaining from: [Trayr 1 ¥ ]
=
Save Settings !&! Cancel I Print “
3. Specify the functions that you want to set.
2.7.1 (108)
Printer: [Document Centre 285 i] Destination:
- [ Printer Specific Optio... | 2] =
Resolution: | 600dpi ¢|
Halftone: | Dot256 2]
Image Enhancement: | On ¥ I
Draft Mode:
Qutput Destination: [ Center Output Tray B
lob Offset: | None ¥ I
Collated:
Transparency Separators: Z
=
Save Settings !ﬂ}h‘e Cancel I Print "

Settings

This section describes the settings of the Printer Specific Options list.

The settings that can be selected vary depending on which options
have been installed. Make these settings after specifying the installed
options in Configure.

See “Configure Settings” on page 6-7.

Resolution - Displays the resolution. The resolution of this machine is
fixed at 600 dpi.

Halftone - Specifies the type of halftone.

When halftones can be adjusted in the application, this setting may be
disabled.



Image Enhancement - Selects whether to use the Image
Enhancement function.

Selecting On smooths the boundaries between black and white when
printing. This reduces the jagged edges, thereby artificially increasing
the resolution of the image. When printing an image (bitmap)
composed of coarse halftone dots, smooth color gradation is
impossible in certain situations. In this case, select Off.

Draft Mode - Specifies whether to reduce the amount of toner used
when printing drafts.

When you select On, the overall printed color becomes lighter. This is
best for printing documents when print quality is not necessary.

Output Destination - Specifies the output destination.

Job Offset - Shifting the output positions of adjacent jobs (print
command) or copies (sets) is called Job Offset. The positions of the
adjacent jobs or sets of copies are shifted to either sides of the output
tray.

Collated - Selects whether to collate a multiple-page file per set when
they are printed.

This function is enabled when the printer HDD kit is installed.

Transparency Dividers - Specifies whether to use transparency
dividers and the source of the dividers, if selected.

Select Auto for the paper source to automatically feed from the paper
tray with paper of the same size and in the same orientation as
transparencies.

> When anything other than Bypass Tray is selected for Paper Source
in the General tab.

> When anything other than Transparency is selected for the Bypass
Tray Paper Type in the Printer Specific Options.

> When anything other than Center Output Tray is selected for Output
Destination.

» When Print on Both Sides is selected.

Bypass Feed Orientation - Specifies the paper orientation when
printing from the bypass tray. When you set the short edge of the paper
in the bypass tray feed direction, select Landscape. When you set the
long edge of the paper in the bypass tray, select Portrait.

Bypass Tray Paper Type - Selects the type of paper set in the bypass
tray when using the bypass tray.

Stapling - Specifies whether to staple printed documents as well as the
position of the staple.



> When anything other than Finisher Tray is selected for Output
Destination.

» When Job Offset is selected.

Custom Paper Auto Orientation - Specifies whether to correct the
paper orientation when printing on custom paper.

Select On when printing on custom-size paper when the printing result
is shifted at 90 degrees.

Select Substitute Tray - Specifies what action to take when the paper
for the print size is not loaded in the machine.

Use Printer Settings - Uses the printer setting. The settings can
be confirmed on the printer control panel.

Display message - Displays paper supply messages on the printer
control panel. Printing is unavailable until paper is supplied.

Use Nearest Size (with Zoom) - Selects the nearest paper size
and prints. Automatically reduces images for printing, as
necessary.

Use Nearest Size (no Zoom) - Selects the nearest paper size and
prints in an equal size.

Use Larger Size (with Zoom) - Prints in an equal size on paper
larger than the original. Automatically reduces images for printing,
as necessary.

Use Larger Size (no Zoom) - Prints in an equal size on paper
larger than the original.



Installing the Screen Fonts

This section explains how to install the fonts in the Screen Font folder.

It is recommended to close all other applications before installing the
fonts. Otherwise, a warning message appears between steps 5 and 6.

1. Start Macintosh and insert the PostScript Driver Library CD-ROM
into the CD-ROM drive.

2. Double-click the [XOPS-PS] icon followed by the Screen Font
folder and then the PS3Fontsinstaller icon. The following window
appears:

AN
Adobe
-~ % ° |
Adobe’ PostScript® 3™ Font Installer
1901 08 Adcbe Sytems Inoorporated All Hights reseved .
Adobe,the Adcbe logo, PostSaipt S are wadgemalksofﬁdobe Syste s Inooporated.
3. Click [Continue].
The license agreement dialog appears.
4. Read through the agreement carefully and if you have no

object

ions to it, click [Accept].

(Adobe Systems Incorporated
For

Electronic End User
License Agreement

Computer(s):
3
PLEASE RETURN ANY ACCOMPANYING REGISTRATION FORM TO

RECEIVE REGISTRATION BENEFITS

NOTICE TO USER: THIS IS A CONTRACT. BY INDICATING YOUR

-

Print... ] [ SaveAs...] [ Decline ] || Accept I

The P

S3Fontsinstaller dialog box appears.

5. You may select [Easy Install] or [Custom Install].



Easy Install installs all the fonts provided in the Screen Font folder.

PS3Fontsinstaller =ii————H
Easy Install -
Click Install button to install Type 1 and TrueType fonts for Adobe
PostScript 3.
Version 1.1
Disk space available: 2,097,018 dpproximate disk space needed: 44 732K
— Install Location
Quit I
on the disk “MacOS9E " [ Install )

i

Custom Install installs the selected fonts only. Simply click on the
triangle arrow beside the four categories of fonts to display the
fonts in each category and then check the fonts to be installed. For
example, the diagram below shows that Arial CE of the CE
TrueType fonts is selected.

PS3Fontsinstaller =————\—-H

Custom Install

- O PostScript Type 1
- O TrueType
I O CEType 1
— [E CETrue Type
[ Arial CE
[0 Times New Roman CE

CoECUE

]

Disk space available: 2,097,018 Approximate disk space needed: 1, 530K
— Install Location _
Quit I
on the disk " MacOS9E * | Install |

i

A warning message will appear if you did not quit all other
applications before performing the font installation.

6. Click Install.
The installation of the fonts begins.

After the installation, you have to restart your Macintosh before the
fonts can be used.

Store your CD-ROM in a safe place.



Xerox PS Utility

You can set the printer from your Macintosh using the Xerox PS Utility.
This section describes how to install, remove, and use the Xerox PS
Utility.

Installing the Xerox PS Utility

The installation procedure is described below.

1. Insert the PostScript Driver Library CD-ROM in the CD-ROM drive.
The XOPS-PS icon appears on the desktop.

2. Double-click the [XOPS-PS] icon.
The XOPS-PS window opens.

3. Copy the Xerox PS Utility folder to the Macintosh hard disk.
The Xerox PS Utility is installed.

See “Using the Xerox PS Utility” on page 6-14 for details about how to
use the Xerox PS Utility.

Store your CD-ROM in a safe place.

Uninstalling the Xerox PS Utility

1. Move the Xerox PS Utility folder from the Macintosh hard disk to
the Trash icon.

The Xerox PS Utility is removed.



Using the Xerox PS Utility

You can download PS files to the machine, and set the printer name
and EtherTalk zones with the Xerox PS Utility. This section describes
how to activate and use the Xerox PS Utility.

You need to install the Xerox PS Utility. See “Installing the Xerox PS
Utility” on page 6-13 for details about how to install the Xerox PS Utility.

Activating the Xerox PS Utility

1. Double-click Xerox PS Utility in the Xerox PS Ultility folder.

The Xerox PS Utility main window appears. Use the menu bar or
the button to use it.

O=—————————————rujiXerxPSlliy=—"————H
+
X
r—Printer Status
—Printer Settings  — —Printer Name

Document Centre 285
Paper Source

[ Paper Source | —tob
Paper Output Status: Job wait
Parallel Port Joby Name:

Input:

—Test Print —

Printer Settings
Font List

Cleaning

—Error

!

Re-confirm

To exit the Xerox PS Utility, click Quit on the File menu.

Specifying the Printer Settings

1. Specify the printer settings.
For details on the individual items, click [Help].

Download PS File - Select the [Download PS file] command from
the File menu.

This command downloads the PostScript file to your printer for
printing. Locate the file to be downloaded to the printer and click
Open. You may select whether to display the result on the screen
or save it to file.



[ G psfiles | %] = Mac0S9E

H

Show result on the screen = I

Printer Name - The Printer Name Settings window is displayed by
selecting the Printer Name command from the Settings menu. You
may change the printer name in this window.

Printar Name Settings

Specify the new printer name using alphanumeric with not
maore than 32 characters.

|5FPrinLer |

[ Help | [ Default | [ Cancel | ” ok |

EtherTalk - The EtherTalk Zone Settings window is displayed by
selecting the EtherTalk command from the Settings menu. The
EtherTalk Zone Settings window enables you to confirm the current
EtherTalk zone and to change it.

You cannot specify any zone displayed in the list with a name
longer than 32 characters.

After you have specified the individual items, click [OK].
Update the printer settings and return to the main window.
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/ Cautions and Limitations

About the driver

Cautions and limitations relating to each type of driver are listed
Readme.txt in the PostScript Driver Library CD-ROM. Be sure to read
it before installing the driver.

Installing this PostScript kit

You must install the 64 MB SDRAM kit to use this PostScript kit.

Troubleshooting

See “User Guide (Printer)” for error codes and error messages
displayed on the printer control panel. See “User Guide (Copier)” for
how to deal with paper jams.

Print operation

The printer driver allows you to make selections to print on custom
paper and postcard using duplex and/or stapling feature to the Finisher
Tray. However, these features are actually not available for printing
with the custom paper and postcard.

You can feed custom paper from the bypass tray only. However, when

you select custom paper, the Paper Source selection does not change
to Manual Feed automatically. Please select Manual Feed yourself.
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